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What’s new 

Software 

PC Software bbe++ supports the BenthoTorch. 

Hardware 

First version 

Please Note: 

Decimal points are according to local settings of Windows, i.e. internationally, the decimal point is “ . ” but in 
most of Europe it is „ , “. Please pay attention to this. Most import/export difficulties are caused by the use of the 
“point” or “comma” and vice versa. The software screenshots contain “decimal commas”, i.e. the European 
system. 



What’s new 

bbe BenthoTorch Manual  Page 3 

 

WHAT’S NEW 2 

Software ............................................................................................................................ 2 

Hardware ........................................................................................................................... 2 

GENERAL SAFETY PRECAUTIONS 7 

Cleaning the instrument: ................................................................................................. 7 

Supplement to the safety instructions ............................................................................ 7 

QUICK START INSTRUCTIONS 8 

OPERATING PRINCIPLES AND DESIGN 11 

Principles of Operation .................................................................................................. 11 

Fluorescence of different algae classes ........................................................................ 11 

Benthic algae ................................................................................................................ 11 

Design ............................................................................................................................. 12 

Measurements ............................................................................................................... 12 

Operation ...................................................................................................................... 12 

USE OF THE BENTHOTORCH 13 

USB connecting cable of the BenthoTorch .................................................................. 13 

Power supply of the BenthoTorch ................................................................................. 13 

Use of the BenthoTorch with the powersupply ............................................................ 13 

Charging the BenthoTorch with the powersupply ....................................................... 14 

Starting the BenthoTorch............................................................................................... 14 

Automatic Power-Down ................................................................................................. 14 

Operation Modes ............................................................................................................ 15 

Operation of the BenthoTorch by Capacitive Touch Keys .......................................... 15 

Storing the BenthoTorch................................................................................................ 16 

Structure of the Internal Software ................................................................................. 17 

Navigation within the Software ...................................................................................... 18 

Entering Settings ........................................................................................................... 18 

OPERATING THE BBE BENTHOTORCH 19 

Measuring Procedure ..................................................................................................... 19 

Single Measurement...................................................................................................... 19 

Interval / continuous measurement ................................................................................ 20 

Reference method for chlorophyll-a measurement for validation of the bbe BenthoTorch 20 

Substrate used for reference ......................................................................................... 20 

Measurement by bbe BT ............................................................................................... 21 

Scraping and transport .................................................................................................. 21 

Extraction and measurement of chlorophyll-a(DIN 38 412-L16) .................................... 21 

Data Menu / view data .................................................................................................... 23 



What’s new 

bbe BenthoTorch Manual  Page 4 

data -> view ................................................................................................................... 23 

Data -> delete ................................................................................................................ 23 

Settings Menu ................................................................................................................. 24 

Overview ....................................................................................................................... 24 

Mode ............................................................................................................................. 24 

Measuring duration ........................................................................................................ 24 

Measuring interval ......................................................................................................... 24 

AutoPowerDown ............................................................................................................ 25 

Clock -> date ................................................................................................................. 25 

Clock -> time ................................................................................................................. 25 

Clock -> Sync. GPS time ............................................................................................... 25 

Clock -> UTC time shift ................................................................................................. 26 

Clock -> Daylight saving ................................................................................................ 26 

Display -> Contrast ........................................................................................................ 26 

Display -> Brightness .................................................................................................... 26 

Software version ............................................................................................................ 27 

Calibration Menu ............................................................................................................ 27 

General considerations .................................................................................................. 27 

Offset calibration procedures ........................................................................................ 28 

Reflectance calibration procedures .............................................................................. 29 

Fingerprint calibration procedures ............................................................................... 29 

Internal Temperature ...................................................................................................... 32 

Show internal temperature: ........................................................................................... 32 

Voltage ............................................................................................................................ 32 

Show voltage: ................................................................................................................ 32 

Calibrate voltage: .......................................................................................................... 32 

Factory settings .............................................................................................................. 32 

Correction factor ............................................................................................................ 33 

Connecting the bbe AlgaeTorch / BenthoTorch / AlgaeLabAnalyzer via USB to a PC33 

USB Driver Set-Up ........................................................................................................ 33 

BBE++ SOFTWARE 35 

Software Set-Up .............................................................................................................. 35 

Desktop icon of the bbe++ software .............................................................................. 37 

bbe++ software in the Start menu ................................................................................. 37 

Software Update ............................................................................................................. 38 

Structure of the software ............................................................................................... 38 

Menu structure (“Basic functionality”) ......................................................................... 39 

Menu structure (”Advanced functionality”) .................................................................. 40 

General considerations for storing and displaying data and parameters in bbe++ .. 41 

What is stored in a bbe++ database? ............................................................................ 41 

Where is the database stored?...................................................................................... 41 

How to display the data? ............................................................................................... 41 

Simultaneous display of data of different types of instruments ...................................... 41 

Who can access to the parameters of the instruments? ................................................ 42 

Desktop of the bbe++ Software. .................................................................................... 42 

Toolbar .......................................................................................................................... 42 

Toolbar instrument ........................................................................................................ 42 



What’s new 

bbe BenthoTorch Manual Page 5 

Graphic- und table views ............................................................................................... 43
Serial number, voltage of the battery, internal clock ...................................................... 43

THE MENUS 44

File Menu ...................................................................................................................... 44
New 44
Open 45
Close 45
Import (FluoroProbe / AlgaeTorch / BenthoTorch) 45
Export (ASCII) 47
Export (Database) 47
Export (KMZ) – AlgaeTorch / BenthoTorch / FluoroProbe 47
Export (ToxTest protocol) – AlgaeLabAnalyser only 47
Summary View 47
1. ... 2. ... 3. ... 48
Data Directory 48
Exit 48

Edit Menu ...................................................................................................................... 49
Copy 49
Edit Comment – advanced functionality only 50
Delete Data – advanced functionality only 51

Parameters Menu .......................................................................................................... 52
Overview 54
History – advanced functionality only 55
Recalc  – advanced functionality only 56

View Menu ..................................................................................................................... 59
Toolbar 59
Status Bar 60
Measurement 60
Macro 60
Data Navigation 60
Period 60
Session 61
Connection State 61
Auto-Update 61

Window – Advanced functionality only ........................................................................... 61
New Table Window 61
New XYGraph Window 62
New Single Value View 62
Cascade 63
Tile Horizontally/Vertically 64
Select Data 64
View Editor 65
Comment Fields 78
1. ... 2. ... 3. ... 78

Tools ............................................................................................................................. 78
Settings 78
Enable advanced/basic functionality 85
Connect COM port 86
Device 86
SQL Script 87

Help ............................................................................................................................... 87
About … 87
bbe++ manuals … 88

The Views ........................................................................................................................ 88
Table views ................................................................................................................... 88

History of Parameters 89
Edit comment 89
Data selection 90
Sorting of the list view 90

XY graph views ............................................................................................................. 91



What’s new 

bbe BenthoTorch Manual  Page 6 

Select data of interest 91 

Right-click menu ............................................................................................................ 93 

Scaling of the axis 94 

Autoscaling 95 

Parameters 95 

Default scaling 95 

PARAMETERS 96 

THE GPS MODULE 98 

The GPS module of the bbe AlgaeTorch and bbe BenthoTorch .................................... 98 

General remarks ........................................................................................................... 98 

Actvating and deactivating ............................................................................................. 98 

position (Settings -> GPS -> position) ........................................................................... 98 

Required quality (Settings -> GPS -> required quality) .................................................. 98 

Version (Settings -> GPS -> version) ............................................................................ 99 

Starting the measurement ............................................................................................. 99 

Data evaluation within the Torch: .................................................................................. 99 

Data evaluation within bbe++ ........................................................................................ 99 

Data export to Google earth ........................................................................................ 100 

UPDATE OF THE FIRMWARE 102 

TROUBLESHOOTING 104 

Instrument Does Not Start ........................................................................................... 104 

Results vary .................................................................................................................. 104 

DATA AND TABLES 105 

Technical Data .............................................................................................................. 105 

 
 



General Safety Precautions 

bbe BenthoTorch Manual  Page 7 

General Safety Precautions 

 
The bbe BenthoTorch is an instrument for determination of the concentration of chlorophyll on surfacees or on 
the ground of a water body. It should only be used for this purpose. 
 
Only instructed staff should operate this instrument. 
 
Consult appropriate safety manual in case of using hazardous compounds and solutions. Wear gloves, coat and 
safety goggles. 
 
Electrical connection of the instrument should only be carried out by trained staff. 
 
The instrument should only be opened by authorised staff. 
 
Changes to electrical connections and circuits may cause damage to the instrument and lead to loss of warranty. 
 

Cleaning the instrument: 

The instrument should be cleaned after use. The use of aggressive cleaning fluids or water at high pressure 
should be avoided. Neither should any mechanical cleaners or apparatus come into contact with the sensor 
head or LED display. Attention: in order to obtain exact measurement results, the measuring head should be 
free from grease. 
Before stowing the instruments should be cleaned of dirt under running water. If necessary, normal, 
commercially available washing up liquid can be used. Rub the instrument dry with a soft cloth and take care 
when drying the electrical contacts. 
The simplest way to store the instrument for any length of time is in its original case, in which the accessories 
can also be stored and kept dry. 

Supplement to the safety instructions  

Performing electrical connection may only be carried out by trained personnel. Maintenance, such as e.g. 
exchanging the rechargeable battery pack, may only be carried out by personnel trained and authorised by bbe 
Moldaenke. Replacement parts and repair materials must be issued/released by bbe Moldaenke for each case. 
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Quick start instructions 

 

1. Charge the BenthoTorch by using the power supply connected to the small cable housing of the USB cable 

2. Start the BenthoTorch by turning it upside down and back again in one quick movement.  
 

 
 
If the BenthoTorch is equipped with a reed contact to switch it on with a magnet, a symbol is printed on the 
label of the BenthoTorch. Please tip on the symbol with the magnet to switch the BenthoTorch on. The 
magnetic switch can be used alternatively to the shaking switch. 
 

 
 

3. Use a wrist strap to secure the instrument 

4. Ensure that the connector is closed with the cap 

5. Go to “Start measurement” 

6. Apply the BenthoTorch to the benthic algae. Ensure that the red foam shadows the algae from the light.  

 

Tip this point 
with a magnet to 
start the 
BenthoTorch 
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7. If there is an internal GPS module available and activated, the status of the GPS signal is shown. If the given

quality criteria are met, the measurement starts automatically, otherwise, the poor positioning information can

be used (takepos) or the GPS information can be skipped.

PosFix  Num Quali 
YES        4  95% 
takepos.  skip 

If there is no GPS signal e.g. within buildings only “skip” is available. 

8. During the internal calibration a decreasing number of  #  is shown

############### 
############### 
#####   

During the measurement the remaining time is displayed: 

Measuring 
Time remaining 

5 s 

The end of the measurement is signalled by a short vibration. The result can be read from the display. The 
results of 3 algae classes are shown alternating.  

green: 
   0.7µg/cm’2 

more   <-  ->   ESC 
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cyanos:           
      0.7µg/cm’2 

more   <-  ->   ESC 
 

diatoms:           
      0.7µg/cm’2 
more   <-  ->  ESC 

 
Press “ESC” to return to the start measurement item. 
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Operating Principles and Design 

Principles of Operation 

FLUORESCENCE OF DIFFERENT ALGAE CLASSES 

 
The BenthoTorch is a fluorometer made for quick and easy measurements of benthic algae including an algae 
differentiation measurement. The results are separately given for green algae cyanobacteria and diatoms.  
 
Due to the fact that algae of the same division contain a similar quantity and quality of photosynthetic pigments, 
their fluorescence excitation spectrum (with a fixed emission wavelength at 680nm) is significant. Thus, it is 
possible to differentiate divisions of algae by their fluorescence excitation spectrum.  

The bbe BenthoTorch for algae differentiation uses 7 LEDs for fluorescence excitation. The LEDs emit light at 3 
selected wavelengths (470nm, 525nm, 610nm).  

 

 

 

There is one additional LED of 700nm (not visible in the picture above), that is used to compensate effects of the 
background reflection. 

BENTHIC ALGAE  

Benthic algae are grow in layers on a surface or on the ground of the waterbodies. To measure the chlorophyll 
concentration of these layers two effects have to be taken in account: 
 
The shadowing of the upper layer of algae: 
This shadowing reduces the excitation light in the lower layers and it reduces the fluorescence light on its way to 
the fluorescence detector.  
To compensate this effect a mathematical model is applied in the BenthoTorch. 
 
The reflectance of the background: 
The higher the reflectance of the background, the more excitation light passes the algae layer more than one 
time. This leads to a higher fluorescence signal.  
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To compensate this effect the reflectance of the background is measured with an additional LED. 

Design 

MEASUREMENTS 

• Benthic green algae

• Benthic cyanobacteria

• Benthic diatoms

OPERATION 

• cable-free operation

• display on the instrument

• datalogger

• internal rechargable batteries

• internal display

• 4 capacitive softkeys

• vibration feedback

• position sensors to start the BenthoTorch

• power-down features

Sensor head with 
LEDs and photodiode 

Connector 

Display 

4 capacitive keys 

Carrying eye 
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Use of the BenthoTorch 

USB connecting cable of the BenthoTorch 

 
The BenthoTorch comes with a connecting cable. This cable has two functions: connecting the Torch to a PC 
and connecting a power supply to the torch. 
 

Power supply 
connector

Connector for 
the AlgaeTorch

USB connector 

 

Power supply of the BenthoTorch 

 
The BenthoTorch comes with a power supply to charge the BenthoTorch and use it continuously. The power 
supply comes with different country-specific mains plugs. Choose the connector for your country and click in 
onto the power supply as shown below. 
 

 
 

Use of the BenthoTorch with the powersupply 

 

• Connect the small end of the cable to the box of the “connecting cable” of the BenthoTorch.  

• Connect the power supply to the mains. 

• If the internal battery is not fully charged, charging will start (see below, page 14) 
 
When using the power supply, the BenthoTorch will not switch off completely, but the display illumination will be 
turned off after some minutes if the touch keys have not been used. 
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Charging the BenthoTorch with the powersupply 

 

• Connect the small end of the cable to the box of the “connecting cable” of the BenthoTorch.  

• Connect the power supply to the mains. 
 
The BenthoTorch will start up and show the charging process by moving bars in the battery symbol. 
 

bbe BenthoTorch  
01.06.2008         
12:00:00    menu 

 
When the internal battery is charged completely, the battery symbol will be completely filled and it will stop 
moving. 

Starting the BenthoTorch 

 
The BenthoTorch is equipped with a position sensor. To switch it on, turn the BenthoTorch upside down and 
back again in one quick movement.  

 
 
The BenthoTorch then switches on. Please confirm the start of the instrument by touching the corresponding left 
key. Do not touch any key during the turning procedure. 

 

bbe BenthoTorch 
switch torch on? 
YES               NO 

 
The confirmation is done in order to avoid unwanted starts, for example during transport. 
 
After confirmation, a start-up message with the current time and the status of the internal battery appears: 
 

bbe BenthoTorch  
01.06.2008        
12:00:00    menu 

  
Press the right key to enter the main menu. 

Automatic Power-Down 

 
If the BenthoTorch is being used without a power supply, it switches off automatically after 5 minutes without any 
operation. It then has to be re-started as described above. 
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Operation Modes 

Three operation modes can be used with the BenthoTorch. 

• Single mode:
after starting, one measurement is carried out. The end of the measurement is indicated by a vibration.
Afterwards the result is displayed.

• Continuous  mode:
The BenthoTorch operates continuously with the given parameters Measuring Time. The measurements
are executed directly one after the other.

To interrupt the auto-mode measurement, turn the Algae Torch upside down and back again as described in 
the “Starting the BenthoTorch” section. 

• Interval  mode:
The BenthoTorch operates continuously with the given parameters Measuring Time and Interval. If the
interval is longer than the measuring time, the BenthoTorch switches off between the measurements.
To interrupt the auto-mode measurement, turn the Algae Torch upside down and back again as described
in the “Starting the BenthoTorch” section.

• Under water measurements (divers)
o Activate the interval mode and use a long interval time
o Start the measurement before diving. The first measurement will be taken on air. After that the

BethoTorch will enter the standby mode
o Use the magnetic bar to start the BenthoTorch again. It will conduct one measurement and

enter the standby afterwards
o Repeat this procedure for all measurement sites

Operation of the BenthoTorch by Capacitive Touch Keys 

The BenthoTorch is equipped with 4 capacitive keys with vibration feedback. The keys are located below the 
display. To actuate a key, just touch the marked area. The actuation is reconfirmed by the BenthoTorch via a 
short palpable vibration. 
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The current function of each key is shown on the display. 
 
During the start-up of the instrument the keys are calibrated. So please do not touch the keys during the switch-
on procedure. 
 
During submersion the keys are deactivated. This is recognised by detecting more than one key pressed at the 
same time. The keys are reactivated when the keys are dry again. 

Storing the BenthoTorch 

The best way to store the BenthoTorch is in the original case. The cable and the accessories can also be stored 
in this case. 
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NAVIGATION WITHIN THE SOFTWARE 

The software is structured in menus with different layers. For an overview, please see above. 
 

 
<  SETTINGS  > 

OK   <-   ->   ESC 
 
 

SETTINGS:            
<      Mode      > 
OK   <-   ->   ESC 

 
 

SETTINGS:MODE 
<      Single      > 
OK   <-   ->   ESC 

 
 
Functions of the keys: 
 
OK: To choose the item shown and enterthe submenu 
ESC: To discarde the changes and leave the menu 
<- ->: To navigate within the same menu level. 

ENTERING SETTINGS 

To change the settings of the BenthoTorch, choose the parameter in the SETTINGS menu: 
 
 

Measuring time:  
   10s                
OK   +     -   ESC 

 
 
The underlined number is currently changeable by using the + and – keys. 
 
OK: Confirms the underlined number and moves the cursor one position to the right. If the last number is 

underlined, OK confirms the new setting and returns to the SETTINGS menu. 
+ / -: Changes the currently underlined number 
ESC: Cancels the input and returns to the SETTINGS menu. 
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Operating the bbe BenthoTorch 

Measuring Procedure 

The BenthoTorch was calibrated before delivery with the bbe standard algae types. 

SINGLE MEASUREMENT 

• Start the BenthoTorch

• Use a wrist strap to secure the instrument

• Ensure that the connector is closed with the cap

• Go to “Start measurement”

• Apply the BenthoTorch in to the benthic algae. Ensure that the red foam shadows the algae from the light.

• Replicate the measurement on one stone and average to reduce the effect of patchiness

• During the internal calibration a decreasing number of  #  is shown

############### 
############### 
#####   

• During the measurement the remaining time is displayed:

measuring 
time remaining 

5 s 

• The end of the measurement is signalled by a short vibration. The result can be read from the display. The
results of 3 algae classes are shown alternating.
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green:             
      0.7µg/cm’2 
more  <-  ->  ESC 

 
 

cyanos:           
      0.7µg/cm’2 
more   <-  ->  ESC 

 
 

diatoms:           
      0.7µg/cm’2 
more   <-  ->  ESC 

 

• More switches between the following items: 

• Automatic alternating of the tree algae classes 

• Display of the concentration of cyanobacteria 

• Display of the concentration of green algae 

• Display of the concentration of diatom 

• Display of the time / date of the measurement. 

• Use the arrow keys to display data of another point in time. 

• Press “ESC” to return to the start measurement item. 
 

INTERVAL / CONTINUOUS MEASUREMENT 

• Start the BenthoTorch 

• Use a carrying cable/rope to secure the instrument 

• Ensure that the connector is closed with the cap / dummy connector 

• Do not exceed the maximum depth (10 m / 100 m). 

• Use the continuous mode (settings -> mode -> continuous) 

• Adjust measuring time and interval 

• Go to “Start -> Start continuous measurement” 

• Apply the BenthoTorch in to the benthic algae. Ensure that the red foam shadows the algae from the light. 

• To stop the BenthoTorch, turn it upside down and back between two measurements when the BenthoTorch 
switches off because of the selected measuring interval. If the measuring interval is 0 s, use the exit key 
between two measurements: 

• To read the data, go to “Data -> view” 
 

Reference method for chlorophyll-a measurement for validation of the bbe BenthoTorch 

SUBSTRATE USED FOR REFERENCE 

 
For test purposes, substrata used are exposed, flat materials which are non-fluorescent in visible light and easy 
to scrape: 
 

a. Black PVC plates   (4x6cm) 

b. Gray PVC plates (4,5x7,5cm) 

c. Glass microscopic slides darkened on one side to omit the “double sidedness problem”. 
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MEASUREMENT BY BBE BT 

The samples are measured directly on site with the BT. Each plate is measured a few times (around 

5) to “cover” the whole area. If the biofilm shows high patchiness, more measurements for a more 

representative average value are performed. It is important to remember that the measurement area 

of the BT is only 1cm², in a circle. 

SCRAPING AND TRANSPORT 

It is better to scrape the samples directly “at site”. If such a possibility does not exist, the samples are 

transported to the laboratory. For this, the samples are stored in a foil bag with a piece of a moist 

sponge and filled with air to prevent damage to the biofilm. The closed bags are then stored safely in 

an isolated box with ice packs to keep the samples cool.    

At the laboratory, the flat plates are scraped with the blade of a cutter knife to remove the whole 

biofilm from the substratum without damaging it. The sample is put into 25-50ml of water. The volume 

of the water sample (Vp) and the area scraped (Ascr) should be noted for subsequent calculation. 

Optionally, to create a homogenous sample, the solution is exposed to an ultrasonic bath for 5 

minutes and stirred afterwards. 

EXTRACTION AND MEASUREMENT OF CHLOROPHYLL-A(DIN 38 412-L16) 

 
Materials und Methods: 
 

- Chemicals: 

o 90% ethanol 

o HCl 3M 

 

- Materials/Instruments: 

o Glass fiber filters (Whatman GF/F) 

o Vacuum filtration apparatus  

o Vacuum pump 

o Brown glass bottles (around 50ml for extraction) 

o Pipette 10ml 

o Spectrophotometer (LKB Biochrom 4050 Ultrospec II UV/Vis Spectrophotometer) 

o Cuvette for a spectrophotometer (1cm) 

o Syringe and syringe filter (0,45µm) 

 
Extraction: 
 

Using the vacuum filtration apparatus, the sample is filtrated over a GF/F filter with a vacuum of 

around 400mbar. The filter is put into a brown glass bottle with 10ml (VE) of 90% ethanol making 

sure the whole filter is covered with ethanol. The bottle is closed tight and incubated for 12 to 24h 

in darkness at room temperature. 

Spectrophotometric measurement: 
 



Operating the bbe BenthoTorch 

bbe BenthoTorch Manual Page 22 

After incubation, approximately 3ml of the extract is filtrated with a syringe filter into a cuvette. 

The sample is measured with a spectrophotometer first at a wavelength of 665nm and then at 

750nm both against the offset of reference 90% ethanol solution. The second measurement at 

750nm is used for the compensation of the sample’s turbidity.  

In the second step, 3M HCl (30µl for 10ml of extraction volume) is added to the filtrated extract 

and the solution is shaken. The solution is incubated for 10 minutes in darkness. This converts 

the chlorophyll-a to pheophytin-a. After this process, the extract is measured again in the 

spectrophotometer at 665nm and 750nm over the 90% ethanol reference sample also treated 

with 3M HCl.  

Calculation of the chlorophyll-a concentration: 

The concentration of chlorophyll in µg/L can be calculated from a formula: 

Equation 1 

‘Chlorophyll concentration in µg/L’ 

Av665 ‘Absorbtion at 665nm before acidification’ 

Av750 ‘Absorbtion at 750nm before acidification’ 

An665 ‘Absorbtion at 665nm after acidification’ 

An750 ‘Absorbtion at 750nm after acidification’ 

VE ‘Extract volume’ 

Vp ‘Sample volume’ 

d ‘Cuvette wideness in cm, typical 1cm’ 

The concentration of phaeophytin in µg/L can be calculated from a formula: 

Equation 2 

‘Phaeophytin concentration in µg/L’ 
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Recalculation to concentration in µg/cm² 

Equation 3 

 

  ‘Chlorophyll concentration in µg/cm²’ 

Ascr    ‘Area scraped in cm²’ 

 

Shorter: 
 

 

 
 

Data Menu / view data 

 
The data menu contains the commands for data handling. 

DATA -> VIEW 

To view the measured data go to “data -> view”: 
 
The display shows the date and time of the latest result.  
For details please see the single measurement section on page 19. 

DATA -> DELETE 

Deletes all data from the memory of the BenthoTorch. 
 

DATA-DELETE      
       all         

OK   <-   ->   ESC 
 
OK: 
Deletes all data from the memory. 
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Settings Menu 

OVERVIEW  

Mode Single, continuous or interval measurements 
Measuring duration Set the duration of a single measurement (default = 10s) 
Measuring interval Set the interval between two measurements in interval mode  
Clock -> time Set time 
Clock -> date Set date 
Clock -> Sync GPS time Sets time / date received from the GPS satellite.  
Clock -> UTC time shift Set the time zone 
Clock -> Dayli. saving Toogle between summer and winter setting 
Display -> Contrast Set the contrast of the display 
Display -> Brightness Set the brightness of the display 
Software Version Displays the software version 

MODE  

Changes between single, continuous and interval measurement. 
 

SETTINGS:MODE 
<      Single      > 
OK   <-   ->   ESC 

 

SETTINGS:MODE 
<   Continuous   > 
OK   <-   ->   ESC 

 

SETTINGS:MODE 
<   Interval   > 
OK   <-   ->   ESC 

 

• Single: One single measurement is performed after starting. 

• Continuous: The BenthoTorch performs one measurement directly after the other. 

• Interval: Performs one measurement after the other with the given measuring interval. 

MEASURING DURATION 

Sets the duration of a single measurement (default = 10s) 
 

Measuring dur.: 
   10 s    

OK    +    -    ESC 
 

MEASURING INTERVAL 

Sets the interval between two measurements in interval mode  



Operating the bbe BenthoTorch 

bbe BenthoTorch Manual  Page 25 

AUTOPOWERDOWN 

Sets the time after which the BenthoTorch is automatically turned off, when not operated. It is also possible to 
disable this function. In this case the BenthoTorch will not be switched off. There are several predefined period 
available by using the + and – keys.  
 

AutoPowerDown 
after   5 minutes 
OK    +    -    ESC 

 
One additional option is to disable the power down: 
 

AutoPowerDown 
disabled 

OK    +    -    ESC 
 
The option shall be disabled in during continuous operation. 

CLOCK -> DATE 

Sets the date 
 

SETTINGS:DATE 
   15.02.09    

OK    +    -    ESC 
 

CLOCK -> TIME 

Sets the time  
 

SETTINGS:TIME 
   15:32:43    

OK    +    -    ESC 
 

CLOCK -> SYNC. GPS TIME 

Sets time / date according to the time / date received from the GPS satellite. This function requires a GPS 
receiver within the BenthoTorch and the signal quality needs to be sufficient. 
 

SETTINGS-Clock 
<  Sync. GPS time  > 
OK   <-    ->   ESC 

 
Click OK to synchronise the time settings of the BethoTorch with the satellite settings. 
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Sync. GPS time 
15:47:12 

OK                ESC 
 

CLOCK -> UTC TIME SHIFT 

Sets the time zone 
 

Set hours 
 UTC +1h  0min  

Next    +    -    ESC 
 
Next Go to the setting of minutes 
+ Increase the setting of the hour 
- Decrease the setting of the hour 
Esc Discard entries 
 
Set the hours first, click next, set the minutes and click OK. 

CLOCK -> DAYLIGHT SAVING 

Toogle between summer and winter setting 
 

Daylight saving 
Winter 

OK    set        ESC 
 
Set Toggle to summer 

DISPLAY -> CONTRAST 

Sets the contrast of the display (0-16). The result can directly be seen on the display. 
 

Set contrast 
   7    

OK    +    -    ESC 

DISPLAY -> BRIGHTNESS 

Sets the brightness of the display. The result can directly be seen on the display. The brighter the display, the 
more power consumption by the display. 
 

Set brightness 
   50 %    

OK    +    -    ESC 
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Mark 

SOFTWARE VERSION 

Displays the software version and serial number. This is useful information to help bbe service answer specific 
questions. 
 

S.Nr. Ato-03-002 
SW ver. 1.04 

OK                     
 

Calibration Menu 

 
The calibration menu is password-protected to prevent it from unintentional changes 
 

Enter Password:  
     0  0  0  0      
OK   +     -   ESC 

 
The default password is 1234.  

General considerations  

 
The calibration of the BenthoTorch includes 3 steps: 
 
Calibration of the offset: 
This is the signal of a black surface without any fluorescing material. This is the signal triggered by the coloured 
LED´s on the black surface. 
 
Calibration of the reflectance: 
To calibrate the reflectance the measurements with a black, a grey and a with surface have to be conducted. 
This is the signal triggered by the nearly invisible 700nm LED. 
 
Calibration of the fingerprints: 
This calibration has to be conducted with a low and a high concentration of each algae class. 
 
The calibration of the BenthoTorch requires a calibration of all backgrounds and fingerprints at once, because all 
dependencies have to be recalculated. Only the offset can be recalibrated seperately.  
 
The procedure is as follows: 
3 Offset calibrations and 3x2 algae calibrations are conducted. After each calibrating the  parameter is marked in 
the menu. As long as the new calibration has not been calculated, the measurements can be repeated if 
required. Each single calibration measurement, that has been conducted, is marked in the display. 
 
 
 

SET OFFSET:        
<     black     > 
OK   <-  ->   ESC 
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SET OFFSET:    v---- 
<     black     > 
OK   <-  ->   ESC 

 
When all calibrations are done, the all calibration parameter can be calculated at once: 
 

Cal. Competed: 
Calculate now? 
YES             NO 

 
For each calibrations a single calibration plate with a cavity of 100µl is delivered together with the instrument. 
Do not use the calibration plates for offset and reflectivity with algae to prevent wrong calibrations. 

Offset calibration procedures 

 
The offset is the detected fluorescence signal without any fluorescing matter. This is calibrated with a black 
calibration plate delivered together with the instrument. 
 

 
Black calibration plate 

 
1. Put the BenthoTorch on the black calibration plate containing 100µl of destilled water. Do not reuse an 

algae calibration plate to avoid contaminations. 
2. Got to calibration -> offset 

 

CALIBRATION:     
<    Offset    > 
OK   <-  ->   ESC 

 
3. Touch the OK key to start. 

 

SET OFFSET:     
use black plate 
Start         ESC 

 
4. After the measurement the results are shown, please confirm it. 
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Reflectance calibration procedures 

 
The reflectance has to be calibrated by using plates with a defined level of reflectance. This calibration is 
performed using a black, a grey and a white calibration plate. The measurement of the black plate is the offset 
measurement, described above. 
 
Please note: 
The grey and the white plate are made for reflectance measurements only.  
 
For the calibration procedures using the calibration plates, please remove the red foam from the BethoTorch. 
 

1. Put the BenthoTorch on the grey  calibration without water. 
2. Got to calibration -> background -> gray 

 

CALIBRATION:     
<   Background  > 
OK   <-  ->   ESC 

 
 

SET BACKGROUND:  
<     grey     > 
OK   <-  ->   ESC 

 
3. Touch the OK key to start. 

 
 

0: 1000  1:5000 
2: 6000  3:7000 
confirm       ESC 

 
4. After the measurement the results are shown, please confirm it. 

 

SET BACKGROUND:v 
<     grey     > 
OK   <-  ->   ESC 

 
5. After confirming the background calibration is marked. 
6. Repeat with the white plate 

 

Fingerprint calibration procedures 

 
To calibrate the fingerprints of the algae classes 2 concentration for each algae class are required. A low 
concentration and a high concentration.  
 
Recommendations: 
 
Low concentration: about 1 µg/cm² 
High concentration: about 6 µg/cm² 
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The algae have to be applied in 6 calibration plates. The volume of the cavity in the calibration plate is 100µl. 
The area of the cavity is 1 cm². Please refer to the following table to get the required concentration of the algae 
solution for application. 
 

Number of the plate Concentration plate Concentration solution 

Plate 1 1 µg/cm² diatoms 10000 µg/l 
Plate 2 6 µg/cm² diatoms 60000 µg/l 
Plate 3 1 µg/cm² cyanobacteria 10000 µg/l 
Plate 4 6 µg/cm² cyanobacteria 60000 µg/l 
Plate 5 1 µg/cm² green algae 10000 µg/l 
Plate 6 6 µg/cm² green algae 60000 µg/l 
 
To get a increase the concentration of the algae solution it can be centrifuged with about 2000 rpm for about 
20min. 
 

1. Apply 100µl of the first calibration solution to the first calibration plate 
 

 
 

2. Put the BenthoTorch on the calibration plate 
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3. Go to calibration -> Fingerprint -> diatoms 
4. Touch the OK key to choose diatoms. 

 

SET FP 
<     diatoms    > 
OK   <-  ->    ESC 

 
5. Select low concentration  

 
 

SET FP DIAS 
<  low conc.   > 
OK   <-  ->   ESC 

 
6. Enter the concentration  

 

enter concentr. 
02.0 µg/cm´2 

OK    +    -    ESC 
 

7. Touch the OK key to start the measurement. 
8. After the measurement the results are shown, please confirm it. 
9. After confirming the concentration is marked. 
10. Repeat with the high concentration3 
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SET FP DIAS 
<   high conc.  > 
OK   <-  ->   ESC 

 
11. Repeat with the other algae classes 
12. When all calibrations are done, the all calibration parameter can be calculated at once: 

 

Cal. Competed: 
Calculate now? 
YES             NO 

 

Internal Temperature 

The internal temperature of the BenthoTorch can be shown.  

SHOW INTERNAL TEMPERATURE: 

 

Int.Temperature: 
       25.5 °C        
OK                      

 
Shows the internal temperature. 

Voltage 

The voltage of the internal rechargeable battery can be shown and calibrated.  

SHOW VOLTAGE: 

 

Battery voltage:  
       6,35 V        
OK                       

 
Shows the measured depth with the current calibration. 

CALIBRATE VOLTAGE: 

Calibration of the voltage shall only done by the bbe service. 
 
 

Factory settings 

 
To reset the instrument to the factory settings including the factory calibration, please use this menu. 
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Restore factory 
settings??        
ESC              OK 

 
Choose OK to reset the settings to the original values. 

Correction factor 

 
The determination of chlorophyll depends on the method of analysis. Even if a lab obtains consistent results – for 
example by diluting – the variation from one lab to another can be enormous. To fit the total chlorophyll 
concentration to your method, this factor can be used. The default setting is 1. To obtain a result which is 10% 
higher, choose 1.1. 
 

gl. corr fact. 
1.00 

OK    +    -    ESC 
 

Connecting the bbe AlgaeTorch / BenthoTorch / AlgaeLabAnalyzer via USB to a PC 

To connect the bbe AlgaeTorch, BenthoTorch or AlgaeLabAnalyser to a PC a USB driver has to be installed first. 
 
Hint: 
Older versions of the converter do not work with Windows 8 and up. Please contact the bbe service. 
 

USB DRIVER SET-UP 

Please insert the bbe CD again. Then, start the application PL2303_Prolific_DriverInstaller.exe in the folder  
<CD-Drive>:\driver\PL2303_Prolific_DriverInstaller 
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Please restart the PC. After that you will find the USB COM port in the system configuration (in this case COM5): 

 

This port is used in the PC software to communicate with the Instrument. 
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bbe++ Software 

 
The bbe++ software is delivered together with bbe instruments. It provides the following functions: 
 

• operation, control and calibration of bbe instruments 

• data analysis and display in tables and diagrams 

• export in different formats 

 
This chapter describes the general functions of the bbe++ software. The examples may show data or 
parameters of other bbe instruments. The data and parameters of your instrument can easily be handled 
accordingly. Whenever this manual deals with special features of a certain instrument, this will be explained in 
the special instrument chapter. 
The data and parameters of the instruments are stored in a database. A single database may contain the data of 
different instruments of the same type and also different types of instruments. 

Software Set-Up 

The software is stored on a CD delivered with the instrument. The latest version can also be downloaded from 
the bbe website after registration (http://www.bbe-moldaenke.de/log-in/ ). 
The Windows autorun function should start the installation automatically. If it does not, open the Explorer and 
click on setup.exe on the CD for installation. 
Welcome window: click “NEXT >” 
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Choose the destination folder and click “NEXT >” 

 

Choose a new start menu folder and click “NEXT >” 

 

Choose your preferred language and click “NEXT >” 
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Final success window of the bbe++ installation. Click “FINISH”. 

 

DESKTOP ICON OF THE BBE++ SOFTWARE 

The setup installs an icon for the bbe++ software on the desktop (if chosen during installation). 

 

BBE++ SOFTWARE IN THE START MENU 

The bbe++ folder in the start menu contains: 
� bbe++ software 

� installed manuals  

� link to the data folder of bbe++ 
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Software Update 

Updates of the bbe++ software and manuals can be downloaded from the bbe website http://www.bbe-
moldaenke.de after registration. 

Structure of the software 

The following menus are available in the bbe++ software. Whether a menu is displayed, depends on the access 
level set. 

• FILE contains all the input/output functions. 

• EDIT contains functions to copy data and graphics. 

• PARAMETER contains functions to set the parameters of an instrument and to adapt the parameters of data 

already measured. 

• VIEW contains functions to show and hide toolbars. 

• WINDOW contains functions to show the data in different types of tables and graphics as well as editors to 

change the layout (advanced functionality level only) 

• TOOLS contains options to change settings that influence the behaviour of the bbe++ software and the way 

of operating the instruments. 

• CALIBRATION contains the items to calibrate different bbe instruments (advanced functionality level only) 

• HELP contains information about the current bbe++ version. 
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General considerations for storing and displaying data and parameters in bbe++ 

WHAT IS STORED IN A BBE++ DATABASE? 

The measuring results and instrument parameters of different bbe instruments are stored. It is possible to 
retrieve the corresponding instrument parameters for each single result. 
In the so-called “Summary View” the serial numbers of the instruments and the time ranges for all data stored in 
this database are shown. This view can be used to select the desired data as well as the corresponding 
parameters for display. 
The database files are marked with the extension *.bdb (bbe database) 
 

WHERE IS THE DATABASE STORED? 

The database of bbe++ is stored in the standard application folder of Windows. The name of the folder depends 
on the operation system and the language. For example: C:\ProgramData\bbe++ in the Windows 7 English 
version. To access this folder easily, there is a link in the start menu called “Data directory”: 
 

 

HOW TO DISPLAY THE DATA? 

In the bbe++ software, different views have been pre-defined for each instrument: 

• graphics 

• tables 

• single dataset 

• data export 

 
User-defined views may be added as well.  

SIMULTANEOUS DISPLAY OF DATA OF DIFFERENT TYPES OF INSTRUMENTS 

After opening a database file, the data of different instruments of the same type may be displayed 
simultaneously. To display the data of another type of instrument from the same database file, this file can be 
opened more than once.  
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WHO CAN ACCESS TO THE PARAMETERS OF THE INSTRUMENTS? 

The bbe++ software has 2 access levels – basic functionality and advanced functionality. Depending on the 
different access levels, more or fewer menu items and parameters are shown. There are different settings for 
reading or writing access. The advanced functionality level can be password protected. 
 

DESKTOP OF THE BBE++ SOFTWARE. 

 

 

 
 
 
 

 
 
 
 
 
 

TOOLBAR 

Toolbar to navigate within the datasets. 

TOOLBAR INSTRUMENT 

Toolbar to operate the instrument 

Toolbar 
 

Data table 

Graph 1 
 

Serial number, voltage of 
the battery, internal clock  
 

Graph 2 
 

Toolbar 
Instrument 
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GRAPHIC- UND TABLE VIEWS 

User configurable windows with graphs and tables. 

SERIAL NUMBER, VOLTAGE OF THE BATTERY, INTERNAL CLOCK  

Display of the data of the connected instrument: serial number, voltage of the battery and internal clock. 
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The Menus 

FILE MENU 

The File Menu contains all the input/output functions.  

 

 

 

New 

Creates a new database file for data and parameters.  

 

If the new database already exists, the existing database is deleted after confirming the following message: 
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The new and empty database is displayed. 

 

New data can be entered in the database by importing or by starting a measurement. 

Open 

Opens an existing database. If there are already data in the database, the “Summary View” window appears. 
The type and serial number of the instrument can be chosen as well as the time range. The following example 
shows a database containing data from different FluoroProbes. 

 

Close 

Closes the active database. 

Import (FluoroProbe / AlgaeTorch / BenthoTorch)  

This function is used to import *.FLP files into the database. These files can be results transferred from the 
FluoroProbe to a USB stick or files generated by the first version of the FluoroProbe software. 
To import, please choose the file from the file system: 
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It is possible to select more than one file by pressing the shift key while selecting the file. 
FluoroProbe only: Afterwards choose how to apply the air pressure and hence the calculation of depth. 

 

AIR PRESSURE AS GIVEN IN FILE (FLUOROPROBE AND ALGAETORCH 100 ONLY) 

Air pressure was measured at the beginning of the measurement. This value is used. 

AIR PRESSURE FROM FIRST DATA SET (FLUOROPROBE AND ALGAETORCH 100 ONLY) 

The first measurement of air pressure took place in air. This is the appropriate selection if an autostart-plug 
without a PC was used (for further information see the FluoroProbe-manual). 

AIR PRESSURE (FLUOROPROBE AND ALGAETORCH 100 ONLY) 

Allows the entry of a constant value. To be used if the FluoroProbe was submerged for a longer time and unable 
to measure the air pressure by itself. 
In case of FluoroProbe data, the results are recalculated from the raw data after importing. 

 

The calculation procedure takes place in subsequent steps. After importing all data, a success message is 
shown. 
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Export (ASCII) 

This item exports the data as an ASCII file to load them into other programs. To select columns to be exported 
and the separator that is used, please see the description of the View Editor. The view editor allows the user to 
define different export formats for each instrument. All export formats of the current instrument are shown in the 
menu: 

 

The default export view is “Export all”. 
After clicking on “Export all”, the name and folder of the exported file can be selected. 
Hint: To transfer data to Excel, use the copy and paste feature in the “Edit” menu. 

Export (Database) 

This item is used to export parts of a database to a new (and smaller) one. The exported database can be read 
with bbe++ again. This might be useful when parts of the database are transferred via email. 
The currently selected data (“WINDOW � SELECT DATA”) are exported. 

Export (KMZ) – AlgaeTorch / BenthoTorch / FluoroProbe 

This item is used to export geo data from instruments with GPS receiver to be displayed in Google Earth. 

Export (ToxTest protocol) – AlgaeLabAnalyser only 

This item is used to export the results of toxicity tests conducted with the AlgaeLabAnalyser to Excel. 

Summary View 

Opens a new window that gives an overview of all the data and instruments in the current database: 

 

The database bbe++.bdb above contains data of two types of instruments: AlgaeTorch and FluoroProbe. 
The serial numbers and the point in time of the first measurement and the last measurement stored in the 
database are shown below the heading with the name of the instrument. 
The header of the window (bbe++.bdb [FP-18-03] :3 has the following meaning: 

• the name of the database      bbe++.bdb 
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• the serial number of the instrument 

for which the data in the data windows are currently shown  [FP-18-03] 

• the number of the window if there is more than one open window :3 

The summary view can be used to directly access the data or parameters of one of the listed instruments. To do 
so, use the right mouse click on the serial number: 

 

A selection of different periods and parameters are shown. After selecting one of the given periods, it is shown 
using the default view.  

 

For further information about the parameters window, please see the chapter Parameters. 

1. ... 2. ... 3. ... 

Names of the last database files opened for quick reload. 

Data Directory 

Opens the explorer with the current data directory to copy or rename the data base. This is the same function as 
in the start menu up to Windows 7. 

Exit 

Terminates the program. 
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EDIT MENU 

This menu contains commands to copy data/graphics from bbe++ and add them to the clipboard. 

 

Copy 

The content of the active window will be copied to the clipboard. Depending on the type of the active window, this 
is either a graph or a table. 
Tables can be pasted to EXCEL directly. 

HOW TO COPY DATA TO EXCEL: 

Use “WINDOW � SELECT DATA” to select the data you want to copy to EXCEL. Use the list window type that 
contains all the columns to be exported. Please note: only the columns from the active view are exported. 

 

• click on “EDIT � COPY”  

• open Excel with an empty datasheet 

• click on “EDIT � PASTE” in Excel 
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Now the data can be used for all kinds off calculations within Excel. 

Edit Comment – advanced functionality only 

To edit the comment of one or more datasets mark the datasets in the table view. A dataset can be marked with 
a mouse click. Multiple datasets can be marked be pressing Ctrl key while clicking on the dataset required. 
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Go to Edit � Edit comments or use right click on the marked datasets: 

 

Enter the new comment for the selected data: 

 

Click OK: 

 

Delete Data – advanced functionality only 

To delete data, mark the datasets as described above. 



The Menus 

bbe BenthoTorch Manual  Page 52 

Go to “EDIT � DELETE DATA” or use right click on the marked datasets: 

 

Click OK to delete the data. 

 

PARAMETERS MENU 

 

This menu contains commands to: 

• display parameters of datasets stored in the database (History) 

 

The following items are not available for AlgaeTorch and BethoTorch: 

 

• apply a user-defined selection of parameters to an instrument (Template) 

• display and change parameters in the instruments (online) 

• recalculate the datasets in the database with another set of calibration parameters (Recalc) 

 

Each selection in the menu leads to one tab of the Parameters window. 

Please note: 
Only parameters of the current type of instrument are shown. 
It depends on the user level, whether a parameter is shown or not. The higher the user level, the 
more parameters are shown. 

For example of parameter listings for user levels, please see the examples below. 
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Access level “advanced functionality”: 

 

Access level “User”: 

 

Depending on the parameters and on the access level, the parameters are read only  or read and write . 
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Overview 

 

TYPE OF OPERATION 

The selection of the type of operation corresponds to the commands in the menu. Depending on the selection, 

different types of operations can be done. 

EXPLANATIONS 

Gives a short introduction to what can be done. 

BUTTONS 

Export: exports the current parameter set to another database for recalculation 

Clipboard: copies the current parameter set to the clipboard to paste it into another application such as Office 

Word or Excel etc. 

Upload: sends the parameters to the connected instrument 

Matrix: shows all the calibration parameters of the connected instrument in one window. 

NAME OF PARAMETER SET 

Each set of parameters can be identified by its time and date. Edited parameter sets or templates have an 

additional name given by the user. 

TYPE OF PARAMETER 

Each tab shows the parameters of a specific topic. 

Command buttons 

Type of operation 

Explanations 

Type of Parameter 

Name / Date of the parameter set 

Values 

Type of parameter set 



The Menus 

bbe BenthoTorch Manual  Page 55 

VALUES 

Shows the current values of the parameters. Depending on the type of operation the value can be edited. 

TYPE OF PARAMETER SET 

Indicates the type of parameter set: 

Original: this parameter set has been used originally for a measurement, it cannot be deleted. 

Adapted: this is a parameter set has been adapted by the user, it can be used to recalculate the datasets. 

 

Shows the current values of the parameters. Depending on the type of operation the value can be edited. 

History – advanced functionality only 

Displays the parameters of the active dataset. 
The history is also available on the Context Menu in table view: 
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All parameter sets in the database can be displayed. To choose one parameter set, select the date from the 
drop-down box: 

 

 

Recalc  – advanced functionality only 

The recalculation option is available in all instruments except for the AlgaeTorch. For the BenthoTorch the 
recalculation is limited to the recalculation by using another parameter set from the BenthoTorch. Editing of the 
parameter sets and templates are not available for the BenthoTorch. 

 

 

To change the settings and recalculate the results, the following steps have to be executed: 

1. Select the instrument and time period (“WINDOW � SELECT DATA”). 

2. Go to “PARAMETERS � RECALC” 

3. Select a new dataset from the dropdown box or create a new one by editing a copy. Please note: only copies 

of an original parameter set can be edited. These sets are marked with “adapted”. 
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4. To create a new parameter set (not in the BenthoTorch), select one, click “CREATE COPY” and enter a name 

for this parameter set. 

  

 

5. Select the new parameter set and edit the settings as described in the “Template” section. Please note the 

number and type of parameters shown depends on the user-level. Only the parameters marked with the 

green symbol can be changed. 
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6. Click “APPLY” to store the changes in the new parameter set. 

7. Click “RECALC” to recalculate the data with the new parameters. 

8. Recalculated data sets are marked in table view at the beginning of each line: 

 

RESTORE DATA WITH ORIGINAL PARAMETERS  

The original data of the measurement is not deleted by the recalculation. It is always possible to see the results 

calculated with the parameters valid when the measurement was taken. 

To restore the original data: 

1. Select the instrument and time period (“WINDOW � SELECT DATA”) 

2. Go to “PARAMETERS � RECALC” 

3. Click “UNDO”. Please note: This item is only available when recalculated data are available in the selected 

time period. 
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DELETE ADAPTED PARAMETER SETS 

To delete adapted parameter sets click “DELETE”. All unused parameter sets will be shown. Parameter sets that 
are in use cannot be deleted. 

 

Select the parameter sets to be deleted and click “DELETE”. 

 

 

VIEW MENU 

 

Toolbar 

Displays or hides the toolbar. 
The toolbar allows quick access to some important instructions: 
 

 
 
 
 

New database 

Open database 

Copy graphic or table to clipboard 
 

Open the Settings dialog 
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Status Bar 

Displays or hides the status bar. 

 

 

Measurement 

Displays / hides the measurement toolbar.  
The toolbar “Measurement” is different for each type of instrument. It allows quick access to functions such as 
starting and stopping the measurement or retrieving the parameters.  
The measurement toolbar of the FluoroProbe is given here as an example: 

 

 

Macro 

The toolbar “Macro” contains buttons to access to the user-defined view macros. For details, please see the 
chapter “TOOLS” � “SETTINGS” � “MACRO MANAGER”. 

 

For the grey buttons, no macro has been defined. 

Data Navigation 

The toolbar “Data navigation” contains buttons to navigate within the data. “One page” corresponds to the time 
scale of the Concentration vs. Time graphs. 

 

� go to the first dataset 

� one page backwards 

� one page forwards 

� go to the last dataset 

 

Period 

The toolbar “Period” contains buttons to scale the time axes to a given value: 
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� 1 hour 

� 6 hours 

� 1 day 

� 7 days 

Session 

The toolbar “Session” contains buttons to navigate from one measurement to another. One measurement is 
defined as a number of consecutive data sets that do not differ in the point of measurement by more than a 
given value. This value can be set in “TOOLS” � “SETTINGS” � “DISPLAY”. 

Connection State 

The toolbar “Connection state” shows the status of the connection to the connected instrument: 

The colour indicates the status: 
Black:   Not connected, the PC has not tried to establish a connection 
Yellow, blinking Not connected, the PC is trying to establish a connection 
Green  Connected 

This is not a button, but an indicator only. 

Auto-Update 

If auto-update is activated and a new data-set is generated during the measurement, this data-set is shown in 
the graphic or list window. If the displayed period does not contain this current point in time, the displayed period 
is changed automatically, so that the latest data-set is shown. 
If auto-update is deactivated, the displayed period does not change. This is useful when doing data analysis 
during the measurement. 

Window – Advanced functionality only 

This menu contains commands to show, arrange and edit different views to display the data. 

New Table Window 

Opens a new window and displays the data according to the selected window type. 
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(See below) 
Please see the list window “Concentration” of an AlgaeTorch as an example. 

 

New XYGraph Window 

Opens a new window and displays the data according to the selected window type. 

 

There are some view types pre-defined for each instrument. It is also possible to add new window types by using 
the view editor. 
The following diagram shows the development of different algae classes measured with the bbe FluoroProbe.  

 

New Single Value View 

Opens a new window and displays the data of one data-set according to the selected window type. 
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The data-set is shown in larger digits to help the user read the display even in bright sunlight. The latest data-set 
is shown. 

 

The “Single Value View” can be adapted to the screen by changing size and/or proportion of the window: 

    

 

Cascade 

Arranges the windows one behind the other. 
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Tile Horizontally/Vertically 

Initiates the organization of the screen into mutually non-overlapping frames. 

Select Data 

The “Select Data” window can be used to select data of a specific instrument and a specific time range from the 
current database. 

    

Type: shows the types of instruments available in this database. 
Unit: shows the serial numbers of the type of instruments chosen above available in this 

database. 

TIME RANGE 

Selects the time range of data to be selected. It is possible to select a fixed time range such as “last month” or to 
do a manual selection by entering a range FROM “date” TO “date”. 

Hint: Further selections can also easily be made in a graphic window. 
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After selecting the time range, the data is shown in the default view. 

 

View Editor 

The View Editor is used to generate your own table or graphic window type as well as a template for the export 
to text files. The View Editor is an assistant that leads through the whole process. 
When starting the View Editor, the current view is selected automatically to be edited or used as a template for a 
new view. Other views may be selected. 
For each instrument there are pre-defined views. These views can be edited but not deleted. Changes in pre-
defined views can be reset to their original status. User-defined views can be edited and deleted. 

GENERATING AND EDITING A TABLE VIEW WINDOW 

To explain the function of the View Editor, in the following steps a table view showing date/time, total chlorophyll 
concentration, Bluegreen concentration and depth is generated as an example.  

View Selection 

1. Open the view editor: 

        

2. Choose the type of instrument the view is to be used for (in the example “FluoroProbe”). 



The Menus 

bbe BenthoTorch Manual  Page 66 

3. Choose the type of view that is to be generated or edited (in the example “Table view / single value 
view”). 

4. Choose one existing view to edit or as a template for a new one. 

In case of a pre-defined view, the view can be reset to the original status (“RESET”). 
In case of a user-defined view, the view can be deleted (choose a custom view and click “DELETE”). 

5. Click “NEXT”. 

Field Configuration 

This window shows all available data of the selected instrument. The left column shows the data that is currently 
not used in the chosen view. In the right column are data that will be displayed in the resulting view. The order in 
the right column corresponds to the order in the table. 

 

6. Click on “Green Algae [µg/l]” and “ REMOVE” to remove the concentration of green algae from the view. 

7. Repeat with all entries but “Date/Time (date)”; “Bluegreen [µg/l]”, “Total conc. [µg/l]” and “Depth [m]”. 

8. Click on “Total conc. [µg/l]” and ”UP” to change the order. 

 

9. Click “Next”. 

 

General Properties 

The General Properties page allows the user to change the background color of a “Single value” view. 
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10. Click on the color picker box behind „Background color“ and choose a new color. 

 

The chosen color is now shown in the color picker box 

 

Example of a change in background color: 

   

Save View 

11. Enter a name for the view. 
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12. Click “OK” to confirm. The current data is then shown with the new view. 

 

13. The new view is now available in the Window menu. 

 

GENERATING AND EDITING A GRAPHIC VIEW WINDOW 

To explain this function, in the following steps a graphic view showing date/time and total chlorophyll 
concentration is generated as an example. 

View Selection 
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1. Open the view editor: 

    

2. Choose the type of instrument the view is to be used for (in the example “FluoroProbe”). 

3. Choose the type of view that is to be generated or edited (in the example “Graphics view”). 

4. Choose one existing view to edit or as a template for a new one (in the example “Conc. / depth”). 

In case of a pre-defined view, the view can be reset to the original status (“RESET”). 
In case of a user-defined view, the custom view can be deleted (“DELETE”). 

5. Click “NEXT”. 

Independent Axis 

6. Choose the design according to the given examples (in the example Y-Axis) 

 

Field Configuration 
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7. Select the data for the axis chosen and click on “ADD�”. Only one of the available entries is possible (in 
the example “Depth”) 

 

8. After choosing one entry all other entries vanish. Removing the entry by clicking “REMOVE” brings back 
all available entries. 

 

9. Click on „PROPERTIES“ 

Axis Properties - first axis 

Some properties can be set for each axis. For the first axis, this is the position and the direction. 

 

Normally the first axis is on the lower or left side of the graph. The direction is normally defined as: 
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X-Axis: left side � low values right side � high values 
Y-Axis: bottom � low values top � high values 
To display e.g. chlorophyll concentration versus depth, it is easier to use the top position of the X-axis and to 
invert the direction of the Y-axis for the depth. Please see the following example: the first picture shows the 
standard settings, the second one with a direction-inverted Y-axis and inverted position of the X-axis. 

 

 

10. Click “OK” to confirm the settings. 

11. Click “NEXT”. 

12. Now the data and settings for the other axis can be selected. 
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Field Configuration - second axis 

 

13. After selecting one type of data, only those types which have the same unit(s) remain in the right 
column. 

 

14. For example, “Total chlorophyll concentration” and “Bluegreen” have to be selected here. 

 

Axis Properties - second axis 
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For the second axis, the properties can be set as shown above. Additionally available scaling options are: 

 

Manual scaling: enter fixed values for the minimum and the maximum of this axis - enter 0 for both to 
disable this feature. 

Auto-scale on: enables the auto-scaling feature - the axis will be scaled so that all selected data are 
visible. 

Auto-scale limits: these settings are used to obtain a nice looking graph in two special situations:  
� datasets with very low noise: 

In the auto-scaling mode, the graph looks as if there are extreme variations, but the 
range is very small due to the auto-scaling. In this case, it is better to use the option: 
lower limit: lower than and 
upper limit: higher than  
This leads to a minimum span in the graph. 

� datasets with outliners: 

In this case, it is difficult to analyze the data because the auto-scaling generates a 
high span value. To prevent this, please use: 
lower limit: higher than for outliners with low values  and 
upper limit: lower than for outliners with high values 
This leads to an optimized span in the graph. 

15. Click “Next” 

Attributes 

This sets the color and size of the dots and lines as well as the color of the background. 
16. Set the value in the attributes window according to your needs. 
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Pixel number: enter the dot size of the value points.  
Background color: click on the colored button to change the background color of the graph. 
For illustration, please see the examples with connected and unconnected dots, different sizes and background 
colors. 
Different dot sizes: 

    

Different background colors: 

    

Column Attributes 
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Select a dataset. 
Color: select a dataset and click on the colored button to change the color of the dots. 
Connected: check the box to connect the dots in the graph. 

 

Hint: The data points are not connected if the time of measurement differs more than the given 
value in “TOOLS ���� SETTINGS ���� DISPLAY”. 

 
Different dot colors: 

    

Unconnected dots / connected dots: 

    

17. Click “Next” 

Save view 

18. Enter a new name for the view. It is not possible to edit pre-defined views. Please store a view based on 
a pre-defined view with a new name. 
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19. The current data is shown using the new view after clicking “OK”. 

 

GENERATING AND EDITING AN ASCII EXPORT 

View Selection 

1. Open the view editor: 

 

2. Choose the type of instrument the export is to be used for (in the example “AlgaeTorch”) 

3. Choose the type of export that is to be generated or edited (in the example “ASCII export”) 

4. Choose one existing view to edit or as a template for a new view. The delete button is used to delete a 
view. It is not possible to delete pre-defined views. 

5. Click “NEXT” 



The Menus 

bbe BenthoTorch Manual  Page 77 

Field Configuration 

This window shows all available data of the selected instrument. The left column shows data which are not 
currently used in the chosen view. In the right column are data that are to be displayed in the view. The order in 
the right column corresponds to the order in the table. 

 

6. Select the required datasets from the right column. Use the up and down buttons to determine the order 
of the data in the export table. 

7. Click “Next”. 

 

 

8. Define separator and end of line characters according to the needs of the importing software. 

9. Click “Next”. 

Save View 

10. Enter a new name for the view. It is not possible to edit pre-defined views. Please store a view based on 
a pre-defined view with a new name. 

 

11. The new view is now available in the “File” menu. 
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Comment Fields 

For each type of instrument, special comments can be defined. These comment fields can be used at the 
beginning of the measurement. The comments names and types can be defined within this dialog. 

 

Type of instrument: the type of instrument is defined in the settings “TOOLS � SETTINGS � ACCESS“. 
Used: if tagged, the comment can be used at the start of the measurement, otherwise the 

comment is hidden. 
Description: name of the comment 
Type: “Text” allows entry of text, “Number” allows digits only; this is relevant for the way the 

comments are sorted in a list view.  
Template: stores the comment definition to transfer it to a new database; the transfer is done 

when opening a new database. 

1. ... 2. ... 3. ... 

Shows all the currently opened windows. 

 

TOOLS 

Menu (advanced functionality) 

 
 
Menu (basic functionality) 

 

Settings 

Here, all the preferences for the general functionality of bbe++ can be set. 
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DATABASE 

The ‘Database’ tab shows the currently used database. The checkbox can be used to open this database after 
starting bbe++. We recommend you to store all the data in the same database. 

 

Automatic start of measurement 

For continuously working instruments (AOA or FluoroProbe / AlgaeTorch) the software can be configurated to 
start the measurement directly after starting the software. The feature can be used to ensure, that the 
measurement starts again after a power fail. 

Auto Archive 

If there are many datasets in the database, navigation in the database becomes slow. The “Auto Archive” 
function automatically archives older data in the database. If there are data older than – in the example – 60 
days, the auto-archive function is started. Only datasets that are a maximum of 30 days old remain in the 
database.  
The archived data is written in a database similar to an exported database. The name corresponds to the date of 
the first dataset in this database. 

DISPLAY 

Enter the time period which defines the maximum interval between two measurements of the same series. The 
setting is used for the “Next measurement” button in the toolbar. 
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Next and previous measurement buttons in the toolbar.  

 

Furthermore, this setting is used to control the drawing of lines between two dots. If the interval between two 
measurements is shorter than the given interval, a line is drawn – otherwise not: 

 

 

Minimal interval set to 10 minutes 

Minimal interval set to 1 minute 
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ACCESS 

Depending on the access level selected, the software shows more or fewer options. The main difference is the 
number of items shown in the menus and the number of parameters shown. 
If an instrument with editable parameters is connected, the same setting is maintained for editing. 

 

User-levels: 
Level     Access 

Basic functionality • Just basic operation of the instrument 

• Measurements with pre-defined parameters only 

Advanced 
functionality 

• All menus accessible / all parameters customizable 

 
The “Advanced functionality” level can be password-protected. As soon as the checkbox is ticked, a password 
can be entered. Afterwards the password is required to enter the Advanced functionality level. 

Please note: 
The “Advanced functionality” level remains until “Basic functionality” level is chosen again. 
Even when restarting the software, the “Advanced functionality” level and a given password will 
still be valid. 

 

Default Device 

The bbe++ software is able to control different types bbe instruments, but only one type at one time. The type of 
instrument is entered here. Various settings within the bbe++ software can only be made for the default type 
instrument. To make entries for an other type of instrument, the default type has to be changed before. 

Offline Mode: 

Choose the offline mode to display data of different type of instruments. If the offline mode is active, no 
measurement is possible. 
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MACRO MANAGER 

The bbe++ software provides the option to store the arrangement of the view windows. One of the stored views 
can be used as the default view automatically displayed after starting bbe++. 

  

 
To generate a new view macro: 

1. Arrange the windows. 

2. Enter the name of the new view. 

3. Check the “Use at program start” box as required. 

4. Confirm. 
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LOGGER SETTINGS 

The logger settings are used in case of problems with the bbe++ software. Please ask the bbe service for 
advice. 
Depending on the checked options more or less information is stored in the file “error.log” in the program folder 
of bbe++ software. 

 

SHORTCUTS 

With the F8 key, one single view can be retrieved. Please enter the single view macro to be used for this. 
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F8 shows the selected macro 

LANGUAGE 

This tab shows a list of the available languages of the bbe++ software. To change the language, choose the 
language you wish and click “OK”. The bbe++ software must be restarted for the changes to take effect. 
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IO MODULS 

This item is used to connect an IO module (for example 4-20mA or relay outputs) to the PC.  

 
• the COM port can either be chosen from the drop down box or the software can search all COM ports for 

the selected instrument. 

• once an instrument has been found the COM port is stored for the next use. 

• To configurate the devices goto Tools -> device -> … . This item is not available for all instruments. 

 

Enable advanced/basic functionality 

Change between advanced and basic functionality. See also Tools -> Settings -> Access. 
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Connect COM port 

 

This item is used to connect an instrument to the PC. 

Please note: 

• bbe++ is looking for an instrument of the selected type only (Tools � Settings � Access). 

• the COM port can either be chosen from the drop down box or the software can search all COM ports for 
the selected instrument. 

• once an instrument has been found the COM port is stored for the next use. 

Device 

The “Device” submenu varies depending on the selected type of instrument. Each type has its own submenu. 

DEMOMODE 

To switch the bbe++ software to the demo mode select FluoroProbe (Tools -> Settings -> Access) and 
disconnect all instruments. Click on “DEMO mode” in the device submenu. Now, the software can be operated 
as if a FluoroProbe were connected. Some procedures such as calibrations are limited in function. 
To reset the demo mode, please restart bbe++. 

 

Once the DEMO mode is selected, the submenu changes to the FluoroProbe entries: 

 

 

ALGAETORCH / BENTHOTORCH SUBMENU 

 

 
 

Enter comment at start of measurement: 

Check to enter one or more comments when starting the measurement procedure. 
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Force import of all data 

The import starts with the latest data. If there are data already in the database, the import stops. The software 
does not look for older, not-imported data to reduce the importing time. 
 
If older data are to be imported, this flag has to be activated. If activated, all data from the FluoroProbe are 
imported. Datasets already in the database are skipped. 

Synchronize device with PC time 

To set the clock of the FluoroProbe, synchronise it with the clock of the PC by activating “Synchronize with PC”. 

Get data from device 

Imports parameters and the latest data that have not been imported yet. The import starts with the latest data. If 
there are data already in the database, the import stops. The software does not look for older, not-imported data 
to reduce the importing time. 

Parameters utility 

Receiving the complete parameters set from the AlgaeTorch / BenthoTorch and sending a Parameters file to the 
instrument. This is supplied by the bbe service in most of the cases. 
 

 
 
 
 

SQL Script 

This function can be used to run an SQL script on the database to reorganise it or to do some special 
calculations. The SQL script is provided by bbe Moldaenke as the case arises. 
 
 

HELP 

 

About … 

Displays the start-up screen. 
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bbe++ manuals … 

List of currently installed bbe++ manuals. Depending on the selection made during the installation, there may be 
manuals in different languages and for different instruments. 

The Views 

TABLE VIEWS 

A table view is opened by “WINDOW � NEW TABLE VIEW � TABLE VIEW NAME“. 

Within the list view, the right mouse button offers detailed information about the selected data set. 
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History of Parameters 

HISTORY OF PARAMETERS shows the corresponding parameters for the given instrument and time. For details, 
see the description of the data menu. 

Edit comment 

EDIT COMMENTS allows the user to change the comments of a specific data set retrospectively. 

The dropdown list contains previously entered comments (if applicable). 
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Data selection 

To add or remove columns from the list view use “Data selection”. The dialog is similar to the dialog of the View 
Editor. 

 

Please select or deselect the columns. The list view is updated immediately. 

Sorting of the list view 

The list view is sorted by date/time. It can be sorted by any other column by clicking on the header of the column. 
Clicking twice leads to the reversed order. 
 
Sorted by time/date ascending: 

 

 
Sorted by time/date descending: 
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Sorted by green algae descending: 

XY GRAPH VIEWS 

Features of the XY graph view: 

9. Select data of interest

10. Scaling of the axes (right click)

11. Display of the corresponding parameters (right click)

12. Editing a XY view, to change colours the type of graph.

13. Navigation within the data

Select data of interest 

Please click and draw the mouse to select the required data. 

A pop-up window is shown to choose the axis to which the selection is to be applied. 
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X only only the selection on the horizontal axis is applied. 
Y only only the selection on the vertical axis is applied. 
X and Y the selection on the horizontal and the vertical axis is applied. 

 

X only applied 
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Right-click menu 

Y only applied 

X and Y applied 
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Features: 

� adjust the scaling . 

� activate and deactivate of the autoscaling feature. 

� show the parameters of a single data-set. 

� return to the default scaling. 

Scaling of the axis 

By default, scaling is done automatically. This means, all datasets of the selected period are displayed. To have 
a closer look at the data, it is sometimes useful to change the scaling. In the right-click menu, there is a “Scale 
axis” option: 
In case of a time axis, the scaling tab of this axis is as follows: 

The first and last point in time have to be entered. 

Hint: For more information on scaling an axis please see the "window" section in this manual. 

In case of a “non-time axis”, more possible adjustments are available: 

Manual scaling: enter fixed values for the minimum and the maximum of this axis - enter 0 for both to 
disable this feature. 

Auto scale limits these settings are used to obtain a nice looking graph in two special situations:  

• data sets with very low noise:

In the auto-scaling mode, the graph looks as if there are extreme variations, but the range 
is very small due to the auto-scaling. In this case, it is better to use the options: 
lower limit: lower than and 
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upper limit: higher than  
This leads to a minimum span in the graph. 
 

• data sets with outliners: 

In this case, it is difficult to analyse the data because the auto scaling generates a high 
span value. To prevent this, please use the 
lower limit: higher than for outliners with low values  and 
upper limit: lower than for outliners with high values 
This leads to an optimised span in the graph. 

Autoscaling  

Enables the auto-scaling feature. The axis will be scaled so that all selected data are visible. 

Parameters 

Show the parameters of the data-set 

Default scaling 

Click here to undo all the changes in the scaling options. 
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Parameters 

Access 
Level 

Name Dimension Meaning 

User Serial number Serial number of the hardware 

User Software version (major) 

User Software version (minor) 

User LED warmup time s Time to warm up the LEDs before a 
measurement takes place 

User Measurement time s Duration of one measurement 

User Measurement interval s  

User Cellcountmode Switches between “µg Chl A/l” and 
“cells/l” 

Display brightness| 
TRENNER |% 
Display contrast| TRENNER 
|digits 

Daylight saving| TRENNER | 

UTC time shift| TRENNER 
|min 
Use GPS| TRENNER | 

GPS minimum accuracy| 
TRENNER |% 
Use GPS| TRENNER | 

Service Wavelength LED0 nm For information only 

Service Wavelength LED1 nm For information only 

Service Wavelength LED2 nm For information only 

Service Wavelength LED3 nm For information only 

Service Measuring type Switches between single, continuous 
and interval measurement  

Service Fingerprint LED 0 Cyanos digits/µg/cm² Result of the calibration of cyanos 

Service Fingerprint LED 1 Cyanos digits/µg/cm² Result of the calibration of cyanos 

Service Fingerprint LED 2 Cyanos digits/µg/cm² Result of the calibration of cyanos 

Service Fingerprint LED 3 Cyanos digits/µg/cm² Result of the calibration of cyanos 

Service Fingerprint LED 0 green algae digits/µg/cm² Result of the calibration of green 
algae 

Service Fingerprint LED 1 green algae digits/µg/cm² Result of the calibration of green 
algae 

Service Fingerprint LED 2 green algae digits/µg/cm² Result of the calibration of green 
algae 

Service Fingerprint LED 3 green algae digits/µg/cm² Result of the calibration of green 
algae 

Service Fingerprint LED 0 Diatoms digits/µg/cm² Result of the calibration of Diatoms 

Service Fingerprint LED 1 Diatoms digits/µg/cm² Result of the calibration of Diatoms 

Service Fingerprint LED 2 Diatoms digits/µg/cm² Result of the calibration of Diatoms 

Service Fingerprint LED 3 Diatoms digits/µg/cm² Result of the calibration of Diatoms 

Service Offset LED 0 digits Signal of pure water 

Service Offset LED 1 digits Signal of pure water 

Service Offset LED 2 digits Signal of pure water 

Service Offset LED 3 digits Signal of pure water 

Service Cellcount factor Cyanos cells/µg/cm² Factor to convert µg/l in cells /l 

Service Cellcount factor green algae cells/µg/cm² Factor to convert µg/l in cells /l 

Service Cellcount factor Diatoms cells/µg/cm² Factor to convert µg/l in cells /l 

Service Global correction factor 1/100 Factor to adapt the results to a local 
reference method 

Time to Auto Power-
Downminutes 
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Expert req. val. LED 0 [nm] digits For brightness control 

Expert req. val. LED 1 [nm] digits For brightness control 

Expert req. val. LED 2 [nm] digits For brightness control 

Expert req. val. LED 3 [nm] digits For brightness control 

Expert Name algae class 0 

Expert Name algae class 1 

Expert Name algae class 2 
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The GPS module 

THE GPS MODULE OF THE BBE ALGAETORCH AND BBE BENTHOTORCH 

GENERAL REMARKS 

The bbe AlgaeTorch and bbe  BenthoTorch are equipped with a GPS module that allows the user to determine 
the position of each measurement. The position data are stored additionally with each dataset within the 
instrument. 

For data evaluation, the results can be read from the instruments display or transferred to the bbe++ PC 
software. bbe++ offers an export of the data to Google Earth to display the chlorophyll results on a map. 

The GPS module is made for outdoor operation. Within buildings, the satellite signals cannot be detected. For 
this case, the GPS module can be deactivated.  

Please note: 
After starting the Algae- or BenthoTorch especially after a longer time or after transporting the instrument, it 
takes some minutes to obtain the correct position. 

ACTVATING AND DEACTIVATING 

To deactivate the GPS module (it is activated by default), go to “Settings -> GPS -> GPS mode”, to deactivate 
the GPS. 

GPS is currently 
   on   

OK   on   off   ESC 

If the GPS is activated and the position has been found, this is indicated on the display: 

bbe AlgaeTorch  
01.06.2010   GPS 
12:00:00    menu 

POSITION (SETTINGS -> GPS -> POSITION) 

This screen is only available if the signal quality is sufficient. 

54°20.3644`N 
10°05.8699`E 

Sat: 5 Q: 92%  OK 

Sat: Shows the number of satellites from which the GPS module receives signals. 
Quality: Shows the quality and hence the precision of the position.  

REQUIRED QUALITY (SETTINGS -> GPS -> REQUIRED QUALITY) 

The quality of the GPS signal is so much the better the more satellites are available and the better the satellites 
are distributed. The quality is calculated. The required quality is the quality of the GPS signal that leads to an 
instant automatic start of the measurement. If the quality is insufficient, the GPS measurement can be skipped. 
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REQUIRED QUALITY 
   95%   

OK   +   -   ESC 

95% is the standard quality value. 

VERSION (SETTINGS -> GPS -> VERSION) 

AXN-1.30 0145 
Fasttrax IT500 

 OK 

STARTING THE MEASUREMENT 

If the GPS module activated, the status of the GPS signal is shown after starting the measurement. If the given 
quality criteria are met, the measurement starts automatically, otherwise, the poor positioning information can be 
used (takepos) or the GPS information can be skipped. 

PosFix  Num   Quali 
YES        4  95% 
takepos.  skip 

In case there is no GPS signal e.g. within buildings, only “skip” is available. 

DATA EVALUATION WITHIN THE TORCH: 

To view the measured data go to “Data -> View”: 
The display shows the date and time of the latest result. Touch “more” as long as longitude / latitude can be 
read: 

54°20.3644`N 
10°05.8699`E 

more  <-  ->  ESC 

DATA EVALUATION WITHIN BBE++ 

After importing the data to bbe++ go to “Window -> New list window -> Default” to display results and position: 
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If the longitude / latitude columns are not available, use the right mouse button “-> Data selection” to add these 
columns. 

DATA EXPORT TO GOOGLE EARTH 

To display the data with Google Earth, execute the following steps: 

• Activate the GPS measurement within the Algae/BenthoTorch

• Conduct the measurements

• Transfer the data to bbe++ on your PC

• Select the data you want to display

• Go to File -> Export (KMZ) and create a KMZ file

• Download and install Google Earth (http://www.google.de/intl/en/earth/index.html)

• Go to File -> Open within Google Earth and open your *.KMZ to display it

Example of data display using Google Earth: 
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Update of the firmware 

To update the internal software,the following steps are necessary: 

1. Get the Software “BBEFirmwareTool.exe” from bbe service
2. Get the latest firmware version from bbe service
3. Charge the AlgaeTorch resp. BenthoTorch
4. Connect the AlgaeTorch/BenthoTorch to a PC
5. Start BBEFirmwareTool.exe:

6. Choose the COMport
7. Select the firmware update file from your PC
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8. Click OK. The software starts checking the device, its current software version and the status of the
internal battery. If everything is fine, the firmware update starts. Afterwards the AlgaeTorch/BenthoTorch
reboots.

9. The version of the current firmware can be checked at the device display in the settings menu (Settings -
> SW version).



Troubleshooting 

bbe BenthoTorch Manual Page 104 

Troubleshooting 

Instrument Does Not Start 

• rechargeable battery is empty

• power supply is not connected

• timing problem when turning the BenthoTorch. Try again a bit more slowly or quickly. Use the magnetic
switch, if available.

Results vary 

• Replicate and average the measurements on one stone to reduce the effects of patchiness.

Nijverheidsstraat 9, 
6987 EN Giesbeek, The Netherlands
T +31 313 880 200
E info@eijkelkamp.com
I royaleijkelkamp.com
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Data and Tables 

Technical Data 

Measurands concentration of green algae [µg Chl-a/cm
2
],

concentration of cyanobacteria [µg Chl-a/cm
2
],

concentration of diatoms [µg Chl-a/cm
2
],

GPS co-ordinates 
Measuring range 0 - 15 µg Chl-a/cm² 
Resolution 0.1 µg Chl-a/cm² 

Weight 1.3 kg 

Size (H x ∅) 530 x 60mm 

Power supply 110/230 V – 50/60 Hz – 12 V DC 
Power input 10 W 

Protection class IP 68 
Depth range 10 m 
Temperature range (working) -2 - 35°C
Temperature range (storage) 0 - 50°C

Interface USB data port 
Data capacity 1000 datasets 

Accessories hard plastic carrying case, mains unit, manual, software, hand loop 
Options telescopic rod, nylon shoulder bag, SDI-12 with bbe converter 

Nijverheidsstraat 9, 
6987 EN Giesbeek, The Netherlands
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